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Chapter 1:

Introduction
Welcome to the DesignPro Tools for AFP Migration Guide. This guide provides 
information on migrating from the Elixir Application Suite (EAS) to DesignPro Tools. 
This guide is not intended to replace the recommended DesignPro Tools training course. 
Elixir recommends that all DesignPro Tools customers attend an Elixir DesignPro Tools 
training class. 

Information on the following is included in this guide:
Before you install: a checklist.
Installation notes for the migrating user.
Information on licensing and configuration.
Setting up input and output parameters for reading and writing resources.
A workflow comparison between Elixir Application Suite and DesignPro Tools for 
creating a form.
Resource migration.
When and how to upgrade your existing resources to DesignPro Tools.
Specific instructions for certain applications that migrating users should know.
Custom tools and processes.
A look at a few Elixir Application Suite tools that are not supported, or are supported 
differently in DesignPro Tools.

This chapter defines who should use this guide, describes the guides within the DesignPro 
Tools documentation set, and provides Elixir Customer Support and training information.

It is important that all migrating users read this chapter prior to installing, 
configuring, and using DesignPro Tools.
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DesignPro Tools Overview
DesignPro Tools for AFP provides a Windows-based, visual design environment for the 
rapid and cost-effective creation of resources and variable designs for the AFP print 
environment. DesignPro Tools supports integrated OGL and PPFA editors that make it 
easy to create and edit the overlays, fonts, images, and data layout needed for AFP 
printing. Once designed, resources can be saved in the AFP Source or Object format.

Developed according to the published IBM Advanced Function Presentation (AFP) 
standards, DesignPro Tools supports Record Format, as well as Traditional PageDefs and 
enables the management and conversion of resources to different formats.

Associated DesignPro Tools Applications and 
Utilities

DesignPro Tools is a collection of editors, applications and utilities:

DesignPro Manager: a Windows-based desktop program for managing and 
converting resources to multiple supported formats. You can also open other 
DesignPro Tools applications using the Manager.
DesignPro Form Editor: an advanced form design tool used to create and edit 
forms for AFP printers.
DesignPro Visual PPFA: an application for developing overlay, FormDef and 
PageDef resources for IBM PPFA printing. Also allows advanced options such as 
selecting a sample data file for PageDef creation and proofing with that sample data 
file onscreen.
DesignPro Font Editor: aa complete font design application used for creating and 
editing AFP raster fonts, as well as Elixir and PCL fonts. You can also open True 
Type fonts in this editor.
DesignPro Graphics Editor: a full service bitmap editor providing various 
transformations and commands for tiling graphics into raster fonts.

Forms and overlays are two terms for the same resource object. This guide uses 
these terms interchangeably.
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Elixir PrintDriver Pro: a utility for “printing” Windows documents into forms. 
Windows documents can be opened in their original format and printed using the 
Elixir PrintDriver into forms. All supported formats can be created using the 
PrintDriver. 
Elixir Scout: a system service that watches directories for a file or an event to 
perform any number of actions like opening an executable (EXE or COM), running a 
batch file (BAT or CMD), or selecting a process (DLL).
Elixir Viewer: displays printstream and resource files.
AFPDS Tree: displays the hierarchical structure of AFPDS files and the binary data 
contained in the structured field records.

About This Guide?
This guide is divided into two chapters:

Chapter 1: Introduction, provides a general introduction to DesignPro Tools and the 
DesignPro Tools Migration Guide.

Chapter 2: Migration from Elixir Application Suite to DesignPro Tools, provides 
information on migrating from Elixir Application Suite to DesignPro Tools.

Who Should Use This Guide?
Anyone migrating from Elixir Application Suite to DesignPro Tools should start here and 
review this guide for instructions and notes pertaining to installation, configuration, and 
using DesignPro Tools.

This guide assumes you are already familiar with Elixir Application Suite. In addition, 
you should be familiar with Microsoft Windows operations, printer and font management 
operations and PC peripherals. You should also have access to reference manuals for PC 
software and hardware, including any printers you are using for the design and print 
processes.
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Related Guides
If you require further information about a specific topic or wish to obtain product 
background information, reference the following resources, all of which are part of the 
DesignPro Tools for AFP documentation package. 

DesignPro Tools for AFP Getting Started Guide
DesignPro Tools Manager for AFP User Guide
DesignPro Tools Form Editor for AFP User Guide
DesignPro Tools Visual PPFA User Guide
DesignPro Tools Font Editor for AFP User Guide
DesignPro Tools Graphics Editor for AFP User Guide

Conventions
Elixir products adhere to Microsoft Windows conventions for using menus, menu 
commands, dialogs, command buttons, icons and the mouse. See your Windows manual 
for more information.

Refer to the following for more information on the conventions used in this guide:
Typographic Conventions (page 8)
Symbolic Conventions (page 9)

Typographic Conventions
Following typographic conventions are used in this guide to identify special information.

Convention Information Type/Example

Bold type Text for you to enter.
Field names, windows, toolbars, buttons and workspace areas 
within a
task step.
Example: From the File menu, select Open.
Example: Click Edit Property Settings.

Italic type References to other documents and books.

Example: refer to the DesignPro Tools Form Editor for AFP User 
Guide.
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Symbolic Conventions
Look for the following symbols as you read through this guide to identify special 
information:

The Note symbol calls your attention to additional information.

The Tip symbol highlights a helpful tip.

The Shortcut symbol calls your attention to an easier way of accomplishing a 
task.

The Warning symbol warns you of problems you might encounter.

The Migrating Users symbol provides notes and tips for anyone migrating from 
a previous version of DesignPro Tools or Elixir Application Suite. 
Chapter 1: Introduction 9



Getting the Answers You Need
Elixir Technologies provides you with multiple ways to learn and use DesignPro Tools:

Customer Support (page 10)
Elixir Web Site (page 11)
Elixir Training (page 11)
Product Help (page 12)
Release Notes (page 12)

Customer Support
If you purchased this product directly from Elixir Technologies, you can contact the 
Customer Support Center for your region at the number listed below.

North and South America:

+1 805 641 5900 ext. 3
Monday - Friday, 7:00 am to 4:00 pm Pacific Standard Time; if closed, press 2 to 
reach Elixir’s extended Support coverage.
Elx_support@elixir.com

The Question symbol refers you to the online help for more information. 

To open online help:

From the Help menu, select Help Topics.
or

Click  in an open dialog

If you have purchased this product from some other source, please contact the 
authorized support representative from that source. Elixir provides customer 
support for products purchased directly from Elixir.
10 DesignPro Tools® for AFP Migration Guide
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Asia Pacific:

Asia_support@elixir.com

Europe:

+44 (0) 207 993-4811
Monday - Friday, 6:00 am to 4:00 pm Central European Time
+1 805 641 5900 ext. 3
Monday - Friday, 4:00 pm to 2:00 am Central European Time
Europe_support@elixir.com

An Elixir Product Specialist will take your call and ask for the following information:
Your name, organization, telephone number and address.
Elixir product name and version number.
A complete description of the problem, including any error messages printed or 
displayed on your monitor.

Elixir Web Site
You can obtain product support from the Elixir web page at www.elixir.com. 

Select Support to:
Ask a question of Elixir Support.
Download the latest product releases and patches.
View the latest product Release Notes.
Sign up for Elixir Training.
Renew your product license.

Elixir Training
Elixir Technologies offers training for its full-range of Windows-based products. For more 
information, contact Elixir Learning at +1 805 641 5900, ext. 4.
Chapter 1: Introduction 11
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Product Help
Elixir software uses the Microsoft Windows Help program to provide online help for all 
product functions.

This online tool includes step-by-step procedures that you can follow as you work
Context-Sensitive Help can be activated from within the software for certain 

dialogs by clicking  available on the top right corner of a dialog.
Online Help can be opened from any component from the Help menu by selecting 
Contents.

Release Notes
Release Notes display at the start of product installation so you can review them before 
beginning the installation process. Once installation completes, you can access Release 
Notes from the product CD at drive:\Relnotes. There are two formats of the Release Notes 
file: Relnotes.pdf and Relnotes.txt. The TXT file can be viewed using either Notepad or 
WordPad. The PDF file can be viewed using Adobe Reader. 
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Chapter 2:

Migration from Elixir 
Application Suite to 
DesignPro Tools

DesignPro Tools Components
DesignPro Tools is available in the following configurations:

DesignPro Tools Professional (supported output format: AFP, Xerox, Elixir, PCL, 
PS, PDF)
DesignPro Tools for Xerox (supported output formats: Xerox, Elixir, PCL, PS, PDF)
DesignPro Tools for AFP (supported output formats: AFP, Elixir, PCL, PS, PDF)
DesignPro Form Editor (supported output formats: Elixir, PCL, PS, PDF)

The DesignPro Form Editor package provides only Elixir form (ELX, EFR), font (HDR) 
and image (LP3) output formats. A Professional, AFP, or Xerox package is required to 
convert these resources into other print formats. 

In this chapter...

Before You Install: A Checklist

Installation

Setting Input and Output Parameters

Understanding Workflows

Resource Migration

Custom Tools and Processes
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Most customers purchase the standalone Form Editor package when they have more than 
one person designing/editing forms. In such a situation, they purchase multiple stand-
alone Form Editors to generate resources in Elixir formats and one full package of 
DesignPro Tools (Professional, Xerox, or AFP depending on their print environment) to 
convert the Elixir resources.

Before You Install: A Checklist
Before you start installing, configuring, or using DesignPro Tools, here are a few 
questions you should think through and find answers to:

1 Should I install DesignPro Tools on a separate PC or use the PC I am already using 
for Elixir Application Suite?

DesignPro Tools can coexist with Elixir Application Suite without any issues. 
For more information, see “Installation” on page 16.
You should not install DesignPro Tools on a PC that already has Elixir software 
other than the Elixir Application Suite installed, such as Opus.
DesignPro Tools can be installed on a PC with Transformation Suite and    
PageMiner only if the base release for all products is the same. For example, 
DesignPro Tools Version 3.00 can be installed with version 8.00 of 
Transformation Suite and version 4.00 of PageMiner. Contact Elixir Customer 
Support before installing DesignPro Tools on a PC which has Transformation 
Suite and/or PageMiner installed.
DesignPro Tools can be installed with Vitesse on the same PC. Contact Elixir 
Customer Support before installing DesignPro Tools on a PC which has Vitesse 
installed.

2 What Operating System and Print Compilers do I need for DesignPro Tools?
See the Software Requirements section in Chapter 2: Installation of the 
DesignPro Tools for AFP Getting Started Guide.

3 Do I need to worry about concurrent licensing for Elixir Application Suite and 
DesignPro Tools?

No – See “Licensing” on page 20 in this chapter.

Forms and overlays are two terms for the same resource object. This guide uses 
these terms interchangeably.
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4 Now that DesignPro Tools supports using native resources, should I use native 
resources or Elixir resources (or both)?

See “Resource Migration” on page 34 in this chapter.

5 Do I need to move my existing resources into the DesignPro Tools environment 
immediately?

No – See “Resource Migration” on page 34 in this chapter.

6 Can I use EAS AppBuilder PageDefs and FormDefs in Visual PPFA?
Yes – See “Resource Migration” on page 34 in this chapter.
For step by step instructions on upgrading a PageDef and FormDef to Visual 
PPFA, see “Migrating: Visual PPFA” on page 48 in this chapter.

7 Am I using any custom processes (for example, programs built in Visual Basic to 
facilitate certain Elixir Application Suite tasks) with my Elixir Application Suite 
system?

If so, you will need to identify these and determine if they are still needed in 
DesignPro Tools.
Shortcuts to programs and utilities can be added to the DesignPro Manager; see 
the DesignPro Tools Manager for AFP User Guide for instructions on adding 
shortcuts in the DesignPro Manager.

8 Am I using the Dispatcher, Transformer, or Loader in Elixir Application Suite?
Refer to “Custom Tools and Processes” on page 55 for more information:

9 Am I using the Transformer in Elixir Application Suite?
See “Transformer” on page 55 in this chapter.

10 Am I using any custom font or segment mappings?
See “Migrating: Resource Mapping” on page 53 in this chapter.
Chapter 2: Migration from Elixir Application Suite to DesignPro Tools 15



Installation 
Should you install DesignPro Tools on a separate PC from Elixir Application Suite? The 
choice you make depends on your workflow, and how you want to integrate the new 
software into your environment. Some considerations for both options are listed below to 
help you make decision.

When installing DesignPro Tools on a separate PC:
If you want to open existing Elixir Application Suite resources, you will need to 
create a profile referencing the location of those resources on your PC or network.
Profiles are created in the DesignPro Manager. For details, refer to DesignPro Tools 
Manager for AFP User Guide.

When installing DesignPro Tools on the same PC as Elixir Application Suite:
Back up all existing Elixir Application Suite resources before installing DesignPro 
Tools. 
The DesignPro Tools installation will not interfere with your existing resources in 
any way. However, once you open and save a resource in DesignPro Tools, you may 
not be able to open that same resource in Elixir Application Suite again due to 
updates in the Elixir format. This specifically applies to ELX forms; when opened in 
Elixir Application Suite after modification in DesignPro Tools, the Elixir 
Application Suite Form Editor may ignore some objects. For this reason, you may 
wish to have a backup version of each original resource, in the event you need it 
again within Elixir Application Suite.
Recommended Installation Approach:
If you are installing DesignPro Tools on a machine that has an Elixir Application 
Suite installed, we recommend that you install DesignPro Tools in a separate folder. 
Elixir Application Suite is always installed under a folder drive:\Elixir, so it is 
recommended that you change the target folder name to an alternate name during the 
DesignPro Tools installation process. Recommended alternate folder names are:
• DPT
• DPTools
• DesignPro

The DesignPro Tools for AFP Getting Started Guide, provided with every package of 
DesignPro Tools and also available on the product install CD, describes the step-
by-step process of installing DesignPro Tools. Please make sure that you go 
through this guide before installing DesignPro Tools.
16 DesignPro Tools® for AFP Migration Guide



Installing DesignPro Tools in a separate and unique folder will help you keep your 
old and new resources separate. It will also make it easier to identify older resources 
that are no longer in use in the event you wish to move these older resources to 
another location or delete them entirely. Naming the DesignPro Tools folder as 
suggested above will also assist the Elixir Customer Support Team in helping you 
with questions.
During installation, a previous Elixir Application Suite installation is recognized. 
You will be asked if you want to use the same resource location for DesignPro Tools 
as is being used for Elixir Application Suite.

The existing EAS file structure is recognized during install. You are prompted to 
select a resource location for the new installation.

The complete installation process and all software and hardware requirements 
are documented in Chapter 2: Installation of the DesignPro Tools for AFP Getting 
Started Guide.
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The DesignPro Tools installation creates a set of folders organized by resource type that is 
slightly different than Elixir Application Suite systems. The input and output folders for 
each resource type have been eliminated and a single folder for each type is used. 
However, many of the Elixir resource folder locations remain the same. For example, 
Elixir fonts are located in drive:\Elixir\Fonts\Elixir for both Elixir Application Suite and 
DesignPro Tools.

The EAS directory structure. Each resource type has an input and an output folder.

The EAS directory structure. Each resource 
type has an input and an output folder.

The DesignPro Tools directory 
structure. Notice that there is only one 
folder for AFP overlays. This includes 
both input and output overlays.
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If you choose to use a different location for your resources and you want to use Elixir 
Application Suite resources in DesignPro Tools, you will need to create a profile 
referencing the Elixir Application Suite resource location.

Profiles are created in the DesignPro Manager. For instructions on creating profiles, refer 
to the DesignPro Tools Manager for AFP User Guide.

If you choose not to use a different location for your resources, you will need to be 
vigilant about resources needed in Elixir Application Suite. 

Physical path settings for each resource folder are controlled globally by virtual folders in 
the DesignPro Manager, and managed within each DesignPro Tools application using the 
Profile Selection dialog. Changes in virtual folders are posted to a profile file, and 
multiple profile files can be created to enable custom combinations of resource paths. 

If you have multiple customers or projects that require discrete collections of resources, 
you can create individual profiles for each collection of resources and activate those 
profiles during resource editing sessions. For more information on the directory structure, 
refer to “Migrating: Directory Structure” on page 37 in this chapter.

Supported File Formats in DesignPro Tools
DesignPro Tools lets you work with native AFP resources, thus eliminating the need for 
resource conversion. Note that compilers are included in DesignPro Tools. The following 
native formats are supported in DesignPro Tools:

AFP
Forms: OVE, OGL 
Fonts: AFP bounded and unbounded, ATM Type 1, True Type
Images: AFP PSEG, JPG, BMP, TIFF, PNG, PCX
PageDefs/FormDefs: Object (OBJ), Source (PPFA)

Forms, images, and fonts can use the same extensions in DesignPro Tools as are 
used in Elixir Application Suite. Resources are not completely backwards 
compatible, which means any file opened and saved in DesignPro Tools may not 
open correctly in Elixir Application Suite. This specifically applies to ELX forms 
and any AFP format resources created in DesignPro Tools. New functionality 
supported in DesignPro Tools is not available in EAS. 
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PostScript, PCL and PDF Support
In addition to AFP format, DesignPro Tools also provides option for saving your forms in 
PostScript, PCL and PDF format. When saved in PostScript or PCL formats, forms can be 
easily proof printed on network printers. PDF format provides more flexibility and 
portability. You can attach the form to an e-mail and send it for review or approval.

Licensing 
For DesignPro Tools, you will use a new license file. The presence of the new license file 
will not interfere with the existing license for Elixir Application Suite.

Configuration 
The configuration and setup files for DesignPro Tools are stored independently of the 
Elixir Application Suite configuration files. This enables both systems to run 
independently from one another, even when installed on the same PC.

Converter settings (Desktop settings in Elixir Application Suite) will need to be manually 
reset in each DesignPro Tools application. These settings are accessed by selecting Tools, 
Application Format Setting and Input Formats, Output Formats, and/or Elixir 
Properties from the application menu. You can also save the input and output properties 
in a custom EPM file and then load the same EPM file in each application. You can save 
and load EPM files by selecting Tools, Application Format Setting, Load or Save.

Feature Set Comparison
In this section, a comparison of Elixir Suites and DesignPro Tools is provided in the 
following tables. The first table provides a general comparison between Elixir Application 
Suite and DesignPro Tools. The second table provides a comparison between Elixir Form 
and DesignPro Form Editor. The third table compares APPBuilder and Visual PPFA.

For more information on saving and loading EPM files, refer to the DesignPro Tools 
Manager for AFP User Guide.
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Elixir Application Suite vs. DesignPro Tools:

Elixir Application Suite DesignPro Tools

Elixir Application Suite editors work only 
with Elixir-format resources, requiring Elixir 
Desktop to be used to convert native formats 
into Elixir formats before any further usage.

The need to pre-convert resources has been 
eliminated. Instead, a resource, in its native 
AFP format, is loaded directly into the editing 
application using standard File/Open function. 
No pre-conversion of resources (font, form, 
image) is required.

Rigid folder structure for conversions and 
other operations.

Folder structure can be customized. Files can 
be input from or output to any Windows folder 
on the local machine or on the network.

User interface provided very few 
customizing options.

Windows-standard, highly intuitive interface 
with full customizing toolbars.

16 bit environment. 32 bit environment.

AppBuilder for AFP – Option available for 
additional price.

Integrated into DesignPro Tools. Includes 
Visual PPFA for handling PPFA PageDef and 
FormDef. Imports all DBF files created in 
AppBuilder for AFP. Visual PPFA is available 
only in DesignPro Tools for AFP and 
Professional.

PrintDriver – Option available for additional 
price.

Integrated into DesignPro Tools. Includes the 
enhanced PrintDriver Pro that enables user to 
convert Microsoft Windows documents into 
AFP and Elixir forms. It also converts 
resources, such as fonts and images, into target 
formats on the fly. For more information, refer 
to “Conversion from Microsoft Windows and 
PDF File Formats” on page 56.

Elixir Viewer – Option available for 
additional price.

Integrated into DesignPro Tools. Includes 
Elixir Viewer to view various file formats.

No automation capability. Includes Elixir Scout for automation of 
frequently performed operations. For more 
information, refer to “Automated Processing” 
on page 57.

No Profiles facility for multiple users. Profiles for multiple users that preserve 
individual environment settings for each user.
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Elixir Form vs. DesignPro Form Editor:

No Virtual folders capability. Virtual folders enable easy management of 
multiple sets of resources.

Online Help available. Improved Help including context-sensitive, 
Windows-based online help.

Elixir Form DesignPro Form Editor

Input formats: ELX only. Cannot open native 
AFPformats.

Input: ELX, EFR, OGL, OVE, EP (Elixir 
PrintDriver Form) and EMF (Windows EMF).

Output formats: ELX only. Requires 
Converter for conversion to native AFP 
formats.

Output: EFR, OGL, OVE, PostScript, PCL, 
PDF and Image File (TIF). No conversion 
required.

No support for full color images. Full color, highlight color and black and white 
images fully supported.

Supports image formats: LP3, TIF, BMP, 
LW8. Conversion required for other formats.

Supports image formats: JPG, BMP, TIF, PCX, 
PNG, AFP PSegs (IM GOCA, IOCA). No 
conversions required.

Font barcode support. No BCOCA support. Full support for BCOCA and font barcodes. 
Easy barcode inclusion to design through drag-
and-drop.

Grid display and Snap to Grid. No 
Guidelines.

Grid display, Snap to Grid and Guidelines for 
easy alignment and positioning of objects.

Limited zoom level control. Zoom level control from 10% to 1000% with 
‘Fit to page’ and ‘Whole page’ options.

No proofing through preview option 
available.

Instant proofing capability by preview in Elixir 
Viewer. Proof print direction from the Viewer 
on local network PCL/PS printers. For more 
information, refer to “Proofing Variable Data 
Applications” on page 56.

Standard toolset for lines, boxes, ellipses, 
paths and text.

Enhanced toolset for lines, boxes, ellipses, 
paths and text.

No text import option, spell check available. Import RTF and TXT files directly into your 
forms. Edit text just like in a word processor. 
Split, join, justify and reformat text. Run spell 
check as you type or spell check the entire text 
block.

No inline editing of images. Edit images within the DesignPro Form Editor.

Elixir Application Suite DesignPro Tools
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APPBuilder vs. Visual PPFA:

Font mapping is available through mapping 
files that require manual editing.

Includes Resource Map that provides a visual 
interface for easy mapping of fonts.

No resource manager. Resource Manager provides a visual listing of 
all resources, including fonts, graphics and 
color palettes, which are used in a particular 
form. Provides shortcut for easy inclusion, 
removal, or export of these resources.

No option to save or load font lists. Save and import font lists. Import fonts into 
font lists automatically with RTF files.

Data Tags are supported. No visual depiction 
of tag structure in a form.

Data Tags are supported. Manage window 
provides a Tag tree structure for easy 
manipulation and management of tags in a 
form.

16-bit graphical user interface. 32-bit graphical user interface. Easy to use for 
users familiar with Microsoft Windows 
application.

APPBuilder Visual PPFA

No Record format PageDef support. Visual PPFA is the first visual editor in the 
industry to offer Record format PageDef 
support.

No PPFA source code display. Real-time display of PPFA source code.

No comment import from PPFA source. Auto-import of comments from PPFA source.

No facility to generate Object list. Object lists available.

No option to load or view data for mapping 
on PageDef.

Load and view sample data in EBCDIC, ASCII 
and mixed-mode formats.

Data to be defined when fields are entered. 
No drag-n-drop of data possible.

Define records and fields by drag-n-drop of 
fields to the Design Area.

Preview with live data requires IBM viewer, 
not easy to setup.

Instant preview option with live sample data in 
Elixir Viewer (included). Proof validity as IBM 
ACIF is used in the background to generate the 
proof.

N-UP option available. Basic and enhanced N-UP supported with 
improved viewing capabilities.

Floating page segment and form support; no 
viewing capabilities.

Floating page segments and forms visible in 
work area.

Elixir Form DesignPro Form Editor
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Setting Input and Output Parameters 
In each of the DesignPro Tools applications, you can access input and output property 
dialogs for each resource type. Input properties define how a resource is read by the 
application for viewing and editing, and output properties define how a resource is written 
or saved to a target format.

In Elixir Application Suite, all of these properties are set when converting resources on the 
Desktop. In DesignPro Tools, these properties can be accessed in each application when 
opening and saving, as well as in the DesignPro Manager when using the Conversions 
dialog. 

This section shows you how to access these property dialogs. 

Limited to black and white and highlight 
color support, no color support.

Color and full color support for RGB, CMYK 
and OCA color. Black and white and highlight 
colors are also supported.

16-bit graphical user interface. 32-bit graphical user interface. Easy to use for 
users familiar with Microsoft Windows 
applications.

Visual PPFA is available only in DesignPro Tools Professional (supports both 
Xerox and AFP environments) and DesignPro Tools for AFP (supports AFP 
environment only).

In this section, DesignPro Form Editor is used to display input and output 
property dialogs. All DesignPro Tools applications access and display property 
dialogs using the same steps.

APPBuilder Visual PPFA
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1 From the Start menu, select Program, Elixir Applications, DesignPro Tools, 
DesignPro Form Editor.

To access input property pages when opening a resource:

2 From the File menu, select Open.

3 From the Files of Type drop-down list, select AFP Overlay Object (*.ove; *.ovl; 
O1*)
Selecting any format other than EFR displays the Edit Property Settings and Restore 
Default Settings buttons.

Selecting AFP Overlay Object (*.ove; *.ovl;O1*) in the Files of Type drop-down list.
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4 In the left pane, click Elixir.
The Elixir icon automatically locates the default directory for AFP forms from the 
open profile.

5 Click Edit Property Settings.
The AFPDS dialog displays. Properties set in this dialog determine how a form is 
read when a file is opened in DesignPro Form Editor.

The AFPDS input property dialog displays.

The path will automatically update to the specified profile’s directory for the 
selected Files of type if the Elixir icon is selected in the left pane of the dialog. For 
example, the default profile lists drive:\Elixir\Forms\Afp as the directory for AFP 
forms. You can also open a form from a different location by browsing for the 
desired path in the Look in drop-down list.
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6 Click OK to close the dialog.

7 Select an OVE resource and click Open.
The selected form opens in the DesignPro Form Editor. If the form does not open 
properly and messages display in the Messages window, you will need to close the 
file, review and set the appropriate property settings carefully and then reopen the 
form. 

To access output property pages when saving a resource to a target format:

1 Select File, Save as from the menu.

2 From the Save as drop-down list, select AFP Overlay Object (*.ove;O1*).
Selecting any format other than EFR displays the Edit Property Settings and Restore 
Default Settings buttons.

For information on all the options available in the input (parser) property 
dialog(s), refer to the DesignPro Tools Online Help. 

To open the Online Help, click  available on the top right of an open dialog.

Properties set at the time of opening a file are not saved for future use. These 
properties are set at the document level and are not retained once the open 
process is completed. To set the required properties as default, select Tools, 
Application Format Setting, Input Formats and the required input format 
from the application menu. These properties are set at the application level and 
are retained by the system. You are not required to set the properties each time 
you open a file.
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3 In the left pane, click Elixir.
The Elixir icon automatically locates the default directory for AFP forms from the 
open profile.

Selecting AFP Overlay Object (*.ove;O1*) in the Save as drop-down list.

4 Click Edit Property Settings.
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The AFPDS dialog displays Properties set in this dialog affect how the form is saved 
to the target format.

The AFPDS output property dialog displays.

For information on all the options available in the output (converter) property 
dialog(s), refer to the DesignPro Tools Online Help. 

To open the Online Help, click  available on the top right of an open dialog. 
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5 Click OK to close the dialog.

6 Name the output file and click Save.
The form saves in the selected format. If error messages display after saving the 
form, resave the file after reviewing and setting the appropriate property settings 
carefully.

Raster vs. Vector Objects
DesignPro Tools Professional and AFP enable you to convert objects placed on a form to 
either raster or vector objects. 

Properties set at the time of saving a file are not saved for future use. These 
properties are set at the document level and are not retained once the save 
process is completed. To set the required properties as default, select Tools, 
Application Format Setting, Output Formats and the required output 
format from the application menu. These properties are set at the application 
level and are retained by the system. You are not required to set the properties 
each time you save a file.

Raster objects consists of a pattern of individual dots, called pixels, arranged in a grid. Each 
pixel has a specific location and color. Raster images display jagged edges when magnified on 
screen or printed at a large magnification. Raster objects use a simple dot-based format, which 
is easier for a printer to process. AFP high-speed laser printers are fast because they use very 
simple resources. The simpler the format, the faster the printer can print.

Vector objects are defined geometrically using a formula. Vector graphics do not lose clarity or 
detail when scaled to any size or printed at any resolution. Vector objects take valuable 
computing time to create, since each font must be scaled as it is used. This slows printers when 
printing.
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To specify objects as either vector or raster: select Tools, Application Format Setting, 
Output Formats and AFPDS from the application menu. From the dialog that displays, 
select the Page Objects category. You can select from the following options:

Use GOCA graphics (do not rasterize): Uses GOCA graphics objects for images 
in a form, FormDef, or PageDef. The objects are treated as a vector object. AFP 
architecture processes GOCA objects efficiently, and the quality is very high in the 
printed output. 
• Draw area borders separately: Causes the interior of an object and the border 

lines to be drawn as two separate raster images. For example, for a shaded box, 
the interior shade would be drawn as one single borderless shape, and the outline 
would be drawn as another shape with no interior. When a form is re-opened, the 
object interior and border are treated as two separate objects.

All rasterize to image under Overlapping Objects (with unsupported mixing 
mode): Rasterizes overlapping objects into images. The AFP format only supports 
the Source mixing mode; therefore, overlapping objects in the overlay need to be 
rasterized into images.

Understanding Workflows
In this section, two standard workflows for form development are outlined for both Elixir 
Application Suite and DesignPro Tools. The first workflow compares creating a new form. 
The second workflow compares modifying an existing form.

Workflow 1: Creating a new form with new resources

For information on all the options available in the output (converter) property 
dialog(s), refer to the DesignPro Tools Online Help. 

To open the Online Help, click  available on the top right of an open dialog. 

Elixir Application Suite DesignPro Tools

Download and/or place all resources for 
the form (fonts and images) in the 
appropriate Elixir standard directory 
structure.

Download and/or place all resources for 
the form (fonts and images) in the 
appropriate directory structure, as defined 
by the working profile (customizable).

Convert original image (BMP, PCX, TIFF, 
or page segment) to the Elixir LP3 format.

Use BMP, PCX, TIFF, JPG, PNG, or AFP 
page segment formats directly on the form 
in the DesignPro Form Editor or

Convert original image to the Elixir LP3 
format.
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As you can see, the basic workflow is the same with some additional options and 
increased flexibility provided in DesignPro Tools. Also, the need to separately convert 
before and after form creation has been eliminated. You can work directly with AFP 
resources. If you prefer the flexibility and functionality supported by the Elixir format, 
you can still keep the source in Elixir, then save to the AFP format directly in the 
DesignPro Form Editor.

For instructions on accomplishing each of these workflow steps, reference DesignPro 
Tools Online Help.

Use Windows outline fonts (Adobe Type 
1 or True Type) or

Convert Windows or AFP fonts to the 
Elixir HDR format.

Use AFP raster or Windows outline fonts 
(Adobe Type 1 or True Type) or

Convert Windows or AFP fonts to the 
Elixir HDR format.

Create form in the ELX format. Create form in the EFR or ELX format or 

Create form in the OVE or OGL format. 

Convert images to page segments. Save form to the AFP format (images can 
be saved to the AFP format at the same 
time or separately).

Convert fonts to AFP fonts. Save form to the AFP format (fonts can be 
saved to the AFP format at the same time 
or separately).

Convert form to AFP form, Source, or 
Object format.

Save form to the AFP format (fonts and 
images can be saved to the AFP format at 
the same time or separately).

Upload to host. Upload to host.

Elixir Application Suite DesignPro Tools
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Workflow 2: Editing an existing form

Elixir Application 
Suite

DesignPro Tools, using 
Elixir as the source 
format

DesignPro Tools, 
using native 
resources only

Download and place all 
resources (form, fonts and 
images) in the appropriate 
Elixir standard directory 
structure.

Download and place all 
resources (form, fonts, and 
images) in the appropriate 
directory structure, as defined by 
the working profile (Profile can 
be customized).

Download and place all 
resources (form, fonts, and 
images) in the appropriate 
directory structure, as 
defined by the working 
profile (Profile can be 
customized).

Convert original image 
(BMP, PCX, TIFF, or page 
segment) to the Elixir LP3 
format.

Convert original image to the 
Elixir LP3 format.

Use AFP page segment 
directly on the form in the 
DesignPro Form Editor.

Convert AFP fonts to the 
Elixir HDR format.

Convert AFP fonts to the Elixir 
HDR format.

Use AFP raster fonts directly 
on the form in the DesignPro 
Form Editor.

Convert AFP form to the 
Elixir ELX format.

Convert AFP form to the Elixir 
EFR or ELX format.

Use AFP form directly in the 
DesignPro Form Editor.

Modify form and save as 
ELX.

Modify form and save as EFR or 
ELX.

Modify form and save as 
OVE or OGL (fonts and 
images can be re-saved to 
AFP format if necessary).

Convert images to page 
segments.

Save form to the AFP format 
(images can be saved to AFP 
format at the same time or 
separately).

No conversion required.

Convert fonts to AFP fonts. Save form to the AFP format 
(fonts can be saved to AFP 
format at the same time or 
separately).

No conversion required.

Convert form to AFP form, 
Source, or Object format.

Save form to the AFP format 
(fonts and images can be saved 
to AFP format at the same time 
or separately).

No conversion required.

Upload to host. Upload to host. Upload to host.
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Again, the basic workflow is the same with additional options and increased flexibility in 
DesignPro Tools. Working with native resources is a great benefit, especially when there 
are only slight modifications to be made to a form in production: no pre or post-
conversion step is necessary.

Resource Migration
When upgrading to DesignPro Tools, one of your main concerns may be all of your 
existing resources: when and how should you migrate them to DesignPro Tools? 

Initially, it is recommended that you run both systems in parallel while you learn the new 
workflows and tools. Existing resources can be opened in DesignPro Tools, so you can 
update the required resources by saving them into the new format. 

One of the major improvements introduced in DesignPro Tools is its ability to use native 
resources without pre or post-conversion steps. You can choose to use all native, all Elixir, 
or a combination of both types of resources. 

All current Elixir Application Suite print resources are in Elixir legacy formats, which 
include ELX, LP3, HDR, and AppBuilder database files. The DesignPro Tools editors 
support the loading and editing of all these legacy formats. There are, however, some 
important changes to note:

See “Resource Migration” on page 34 for an in-depth discussion on whether to 
use Elixir or native resources. The tables above are provided to show a typical 
workflow using Elixir and native resources in DesignPro Tools, as opposed to 
Elixir Application Suite.

It is recommended that you backup your resources before you start using them in 
DesignPro Tools. Once resources are modified in DesignPro Tools, they may not 
open correctly in Elixir Application Suite.

Native refers to an environment’s own format. AFP resources, such as OVE or 
OGL forms, AFP fonts, and Page Segments are native resources.
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Elixir Form legacy resources
DesignPro Tools can open all ELX files created in previous Elixir Application Suite 
versions. 
Note that the DesignPro Form Editor creates a new file type with an EFR extension. 
Forms can be saved to the legacy ELX format for use in Elixir applications that 
cannot use the EFR files, such as Opus. ELX files can also be reopened in Elixir 
Application Suite, although objects that are not supported by Elixir Application Suite 
will be ignored.
Visual PPFA resources
Visual PPFA imports PageDefs and FormDefs from AppBuilder 4.10 or later 
versions. If you are migrating to Visual PPFA from AppBuilder, and you want to 
import PageDefs and FormDefs from AppBuilder, you must upgrade to AppBuilder 
4.10. Once you have upgraded to AppBuilder 4.10, your files are ready for importing 
into Visual PPFA. Step by step instructions are provided in “Migrating: Visual 
PPFA” on page 48.
Visual PPFA creates new Elixir formats for PageDefs and FormDefs. Each resource 
exists as an individual file. PageDefs are identified with an EPD extension and 
FormDefs with an EFD extension. AppBuilder cannot read the DesignPro Tools 
PageDef and FormDef formats.
Previous EAS AFP systems
Opening or importing output resources created by DesignPro Tools and Visual PPFA 
in previous EAS systems is not recommended, even when the file extensions have 
not changed. This includes source and compiled forms, compiled PageDefs and 
FormDefs, fonts, and page segments created or compiled in one of the DesignPro 
Tools applications. This is due to improvements and updates made to the AFP 
architecture. 

DesignPro Tools supports native, legacy, and its own resource formats. Even with the 
ability to use native resources, you may consider keeping your source files in the Elixir 
format. Some advantages of the Elixir format:

Files can be used for multiple environments. If your original file is in Elixir format, it 
can be modified and then saved to AFP, PCL, PDF and other print formats.
DesignPro Form Editor supports many features not available in native formats. For 
example, AFP forms place each line of text individually. The Elixir format can keep 
text blocks as paragraphs, making them easier to edit.
Visual PPFA PageDefs and FormDefs saved in Elixir Native format support many 
features not available in PPFA source. For example, names for records, fields, and 
other tree objects are not retained and interpreted as comments in PPFA source. Also, 
internal comments and environmental settings, such as Template forms, are only 
saved in the Elixir format.
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Once you become accustomed to the DesignPro Tools environment, and are ready to stop 
using Elixir Application Suite, you have two choices:

Continue to migrate resources one-by-one, as modifications are needed.
Migrate all resources at once by converting them in the Conversions dialog of 
DesignPro Manager.
The Conversions dialog can convert many files to single or multiple output types in 
one session. You can open the Conversions dialog by dragging and dropping files on 
the Converters icon in the Applications tab in the Manager.

A sample batch conversion using the Conversions dialog.

For instructions on converting resources, reference the DesignPro Tools Manager 
for AFP User Guide.
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Migrating: Directory Structure
When migrating, you will want to verify that your profiles are set up correctly in the 
DesignPro Manager. You should check profiles before beginning any work in DesignPro 
Tools.

A profile holds all of the information that was contained by the System.ini file in Elixir 
Application Suite. A default profile is created and stored in the SystemData.ini file, based 
on the information provided during installation, when DesignPro Tools is installed. This 
file establishes the basic operating environment and is located at drive:\Documents and 
Settings\Current User\Application Data\Elixir Technologies\Profiles. 

The profile also includes the directory structure used to identify, read, and write resources. 
When you load a profile in DesignPro Manager, you can verify that the directory structure 
is correct by viewing your virtual folders. Virtual folders are pointers to physical folders 
on your drive or network.

The following sections provide a comparison between the Elixir Application Suite and 
DesignPro Tools directory structure based on the default profile. Many of the old 
directories are no longer mapped because the files formats they previously contained are 
either obsolete or are no longer supported.

For more information about virtual folders and to learn how to map new folders 
and unmap existing folders, refer to Chapter 3: Configuration in the DesignPro 
Tools for AFP Getting Started Guide.
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Documents

In the default profile, the documents are stored under the Documents folder located at 
drive:\Elixir\Docs in DesignPro Tools. The image below provides a comparison of the 
Elixir Application Suite and DesignPro Tools directory structure for documents. The input 
and output folders for each resource type have been eliminated and a single folder for each 
type is used. 

Comparison of the “Docs” directory structure in Elixir Application Suite and DesignPro 
Tools. 
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Fonts
In the default profile, fonts are placed under the fonts folder located at drive:\Elixir\Fonts 
in DesignPro Tools. The image below provides a comparison of the Elixir Application 
Suite and DesignPro Tools directory structure for fonts. The input and output folders for 
each resource type have been eliminated and a single folder for each type is used. 

Comparison of the “Fonts” directory structure in Elixir Application Suite and DesignPro 
Tools. 
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Forms Folder

In the default profile, the forms are placed in the forms folder located at 
drive:\Elixir\Forms in DesignPro Tools. The image below provides a comparison of the 
Elixir Application Suite and DesignPro Tools directory structure for forms. The input and 
output folders for each resource type have been eliminated and a single folder for each 
type is used.

Comparison of the “Forms” directory structure in Elixir Application Suite and DesignPro 
Tools. 
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Graphics Folder

In the default profile, the graphics are stored under the graphics folder located at 
drive:\Elixir\Graphics in DesignPro Tools. The image below provides a comparison of the 
Elixir Application Suite and DesignPro Tools directory structure for graphics. The input 
and output folders for each resource type have been eliminated and a single folder for each 
type is used. 

Comparison of the “Pics” directory structure in Elixir Application Suite and DesignPro 
Tools. 
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Jobs Folder

In the default profile, the jobs are stored under the jobs folder located at drive:\Elixir\Jobs 
in DesignPro Tools. The image below provides a comparison of the Elixir Application 
Suite and DesignPro Tools directory structure for jobs. The input and output folders for 
each resource type have been eliminated and a single folder for each type is used.

Comparison of the “Jobs” directory structure in Elixir Application Suite and DesignPro 
Tools. 

Migrating: Forms
Once the profiles are verified, you can begin migrating your resources. DesignPro Tools 
does not require conversion of resources for the purpose of migration. You can simply 
open your existing resources in DesignPro Tools applications. If you have already used the 
Converter in DesignPro Manager to convert your forms, you can open them in DesignPro 
Form Editor and start editing them.

To open a form:

1 From the Start menu, choose Programs, Elixir Applications, DesignPro Tools, 
DesignPro Form Editor.

2 From the File menu, select Open.
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3 From the Files of Type drop-down list, select your resource type.
Existing Elixir resources use the ELX file extension. The Edit Property Settings and 
Restore Default Settings buttons display when you select a format other than EFR.

4 Browse to select a form.
ELX forms are located at drive:\Elixir\Forms\Elixir.

5 Click Edit Property Settings.
The properties dialog displays for the selected resource type. Properties set in this 
dialog affect how a form is read when opening the file in the DesignPro Form Editor.

6 Set the appropriate settings for your form and click OK to close the dialog.

7 Click Open.
The selected form opens in the DesignPro Form Editor. If there are issues when 
opening the form, you will need to close the file, then review and set the appropriate 
property settings carefully before reopening the form.

The Elixir EFR format provides a single format that saves to virtually all print and 
presentation formats, including AFP, PostScript, PCL, and PDF. The ability to have a 
common file as the source for all environments improves the overall efficiency for 
resource management and production.

To save the form as an EFR:

1 From the File menu, select Save as.

2 From the Save as drop-down list, select Elixir Form (*.efr).

3 Name the file and click Save.

Elixir legacy ELX files created in Elixir Application Suite can be opened directly into 
DesignPro Form Editor without any special preparation. It is important that the paths to 
the Elixir legacy fonts and images are specified correctly so that DesignPro Tools can 
locate the resources. 

For information on all the options available in the input (parser) property 
dialog(s), refer to the DesignPro Tools Online Help. 

To open the Online Help, click  available on the top right of an open dialog. 
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Due to limitations in the ELX format, certain AFP page objects, when converted from 
AFP to Elixir in Elixir Application Suite, are rasterized as images and stored in a special 
folder. The path to this folder is read during DesignPro Tools installation, if the option is 
selected to use Elixir Application Suite path settings, and set in the default profile. If the 
path is not set correctly, it can be set by modifying the 
SYSTEM_GENIMAGE_FILEPATH variable in the profile. This folder is typically 
drive:\Elixir\Pics\Genimage.

Font Lists
DesignPro Tools now provides support for directly importing Elixir Application Suite 
external font list files. P2lfonts.lst files created in Elixir Application Suite can now be 
loaded in DesignPro Tools. 

To import a font list as LST:

1 Open a form in the DesignPro Form Editor.

2 From the File menu, select Import, Font List.
The Open dialog displays.

3 Select LST Files (*.lst) from the Files of Type.

4 Select the required font file and click Open.
The file opens in DesignPro Form Editor.

DesignPro Tools supports a new font list format for importing and exporting font lists 
during form creation. The new font list is saved in an external XML file. The XML file 
can be archived or printed for easy reference, and imported when creating new forms. 

Editing profiles is an advanced topic and is not covered in this guide. For more 
information on profiles, refer to the DesignPro Tools Manager for AFP User Guide.
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To export a font list as XML:

1 Open a form in the DesignPro Form Editor.

2 From the File menu, select Export, Font List.
The Save as dialog displays.

Saving a font list as an XML file.

3 Name the font list and click Save.
The file is saved in XML format.

The exported XML font list cannot be opened in the Elixir Application Suite 
Form Editor.
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To import an XML font list in DesignPro Form Editor:

1 From the File menu, select Import, Font List.
The Open dialog displays.

Loading an XML font list file in DesignPro Form Editor.

2 Select a Font List and click Open.
The font list loads in the open form.

Tags
Tag support is available in DesignPro Tools. The tags in ELX forms are recognized in 
DesignPro Form Editor. The tag structure can be viewed in the Tag Structure tab of the 
Manage window.

You cannot save tag commands to a target format unless you have purchased a 
tagging option (sold separately from DesignPro Tools).
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Proof Printing
The Elixir Application Suite requirement for HP soft fonts for proof printing no longer 
applies.

Color Palettes and Shade Patterns
DesignPro Tools includes the same color palettes and shade patterns provided with Elixir 
Application Suite therefore, existing Elixir legacy forms using these palettes and patterns 
can be used in DesignPro Tools.

Migrating: Fonts
Fonts can be migrated by opening an existing font and then saving it in DesignPro Tools. 
You can also use Elixir legacy fonts saved in Elixir Application Suite without 
modification in the DesignPro Tools editors. This includes both generic Elixir fonts and all 
AFP components. Remember that both Elixir Application Suite and DesignPro Tools use 
the same extension for fonts, so it is possible to overwrite existing fonts. 

Migrating: Images
You can use Elixir legacy images saved in Elixir Application Suite in the DesignPro Tools 
editors without modification. DesignPro Tools supports other image formats, such as JPG, 
BMP, PNG, PCX, and TIFF, which do not need to be converted before they can be used in 
the DesignPro Tools editors. 

The font naming convention has changed in DesignPro Tools for half-point font 
sizes. The new naming convention does not start using the alphabet with a point 
size of 1. This means that a font created with DesignPro Tools may have the same 
name as an existing font, but would be a larger point size. If you use half-point 
font sizes, you may wish to create a virtual folder specifically for DesignPro Tools 
fonts.

Remember that both Elixir Application Suite and DesignPro Tools use the same 
extension for images, so it is possible that existing images might be overwritten.
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Migrating: Visual PPFA
Existing AppBuilder FormDefs and PageDefs can be migrated to Visual PPFA. There are 
two methods to import existing PageDefs and FormDefs in Visual PPFA. 

I. Importing PageDefs and FormDefs using the Elixir AppBuilder Document.dbf file 
in DesignPro Visual PPFA:

1 From the Start menu, choose Programs, Elixir Applications, DesignPro Tools, 
DesignPro Visual PPFA.
DesignPro Visual PPFA opens.

2 From the File menu, select Open.
The Open dialog displays.

3 From the Files of Type drop-down list, select Elixir AppBuilder 4.xx 
(Document.dbf).

4 Browse to drive:\Elixir\Jobs\Elixir and select required database document.

AppBuilder resources cannot be converted using the Conversions dialog into 
the DesignPro Tools format. Each PageDef and FormDef must be opened and 
saved in Visual PPFA to migrate these resources.

In order to migrate AppBuilder PageDef and FormDef resources, you must have 
AppBuilder version 4.10 or higher installed.
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This database stores all FormDef and PageDef information for Elixir AppBuilder.

Selecting the AppBuilder database.

5 Click Open.

The location of the AppBuilder database should be specified in the active profile. 
You can map additional virtual folders to a profile in the DesignPro Manager.
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Visual PPFA prompts you to convert the old version of the database to the new 
format.

You are prompted to convert an older version to the new format.

6 Click Yes.

7 Select PageDef for Database. 
All of the PageDefs in your AppBuilder database display. You can toggle back and 
forth between FormDefs and PageDefs, but can only open one resource type at a 
time.

Selecting a Page Definition to open in Visual PPFA.

8 Select a PageDef from the list and click OK.
The PageDef opens in Visual PPFA.
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9 From the File menu, select Save as, PageDef from the menu.

10 In the Save as drop-down list, select Elixir PageDef (*.epd).

11 Name the new resource and click Save.
You have successfully migrated a PageDef.

II. Importing PageDefs and FormDefs individually:

1 Open Elixir AppBuilder for AFP from Elixir Desktop.

2 From the File menu, select PageDef, Load PageDef.
The Load PageDef dialog displays.

3 Select the required PageDef from the available list and click OK. 
The selected PageDef loads in the AppBuilder Design Area

Follow the above-mentioned steps to load the required FormDef. 

To export PageDefs and FormDefs using Elixir AppBuilder for AFP:

1 From the File menu, select Convert, Export. 
The Export Options dialog displays.

2 Choose the appropriate options for your print environment. 
PageDef and FormDef can be saved in source (PPFA), as well as object (AFPDS) 
formats. 

3 Specify the required names for the PageDef and FormDef. 

4 Click OK.
If you are using the default Elixir folders, the PageDefs and FormDefs will be 
exported to drive:\Elixir\Jobs\Afpout folder.

The process for opening FormDefs is the same as for opening PageDefs. 
FormDefs are saved in Elixir FormDef (EDF) format.
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To import the exported files in DesignPro Visual PPFA:

1 Open DesignPro Visual PPFA.

2 From the File menu, select Open. 

3 Browse to find the exported PageDef. 

4 Select the required PageDef and click Open.

5 Select Project, Load FormDef from the menu to open the required FormDef. 

6 Browse for the FormDef and click Open.

7 After editing, select File, Save and save the PageDef and FormDef one by one. Now, 
you have imported your Appbuilder application in Visual PPFA.

File Settings
Each DesignPro Tools application offers both default property settings for resources and a 
method to temporarily override the defaults if needed for a specific application. You can 
change the default settings by selecting Tools, Application Format Setting and then 
choosing the required Input or Output format from the applications menu. To temporarily 
override these settings, click on the Edit Property Settings button in the Open dialog and 
make the required changes. Once you have saved the resource, the input or output 
properties revert back to their default settings.

You need to make sure that the resources used in PageDefs and FormDefs 
exported from the Elixir AppBuilder for AFP are copied to the correct DesignPro 
Tools directory. Otherwise, error messages for missing resources will display in 
the Messages window. You can use DesignPro Manager to place the resources in 
the correct folders.

For information on all the options available in the input (parser) and output 
(converter) property dialog(s), refer to the DesignPro Tools Online Help. 

To open the Online Help, click  available on the top right of an open dialog. 
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Font and Segment Mapping
Custom mappings for AFP are handled in the Elixir Resource Map. Any default mappings 
from EAS must be manually transferred to the Resource Map.

Settings for OGL MVS DDNAME or VM FILETYPE, defined in Default.fam in EAS, are 
defined in the property pages for OGL output in DesignPro Tools. 

The same settings for images, defined in drive:\Elixir\Pics\Maps\Default.sam in EAS, are 
also defined in the OGL output property pages in DesignPro Tools.

Migrating: Resource Mapping
In Elixir Application Suite, resource mapping is accomplished using a Psfont.map or a 
Default.fam file. All resource mapping for DesignPro Tools is located in the Elixir 
Resource Map. Any previous mappings within Elixir Application Suite mapping files 
need to be defined within the Resource Map.

1 From the DesignPro Manager, DesignPro Form Editor or Visual PPFA application 
menu, select Tools, Resource Map.
The Resource Map opens.

The default mapping within the Resource Map.
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2 Click  next to the Fonts node.
The available font types display. 

3 Select the font type for the Source Font column.
The Source Font types include Raster, Windows, Embedded outline, PCL and AFP.

4 Right-click the table on the right side of the Mappings window and select Add from 
the pop-up menu.
The Font Mapping dialog displays.

5 If mapping an Elixir or Windows font, click Font Selection in the Source category.
The Open dialog displays.

6 Select a font and click OK.

7 Select the Targets category and select the output target types.
Each output target type selected displays as a sub-category under the main Targets 
category.

8 Select the output type sub-category and set the appropriate settings or choose a 
Target font.

9 Click Apply and OK.
The new mapping adds to the Resource Map.

For more information on Font Mapping, refer to the DesignPro Tools Manager for 
AFP User Guide.
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Custom Tools and Processes
Elixir Application Suite includes many tools, processes, and stand-alone utilities. Many of 
these were developed to work specifically with the Elixir legacy ELX format and are tied 
to the Elixir Application Suite directory structure. Shortcuts for the most commonly used 
tools and utilities are provided in the DesignPro Manager. New utilities that duplicate the 
functionality of some Elixir Application Suite utilities will be created for future DesignPro 
Tools releases.

Dispatcher and User Tools
The Elixir Application Suite Desktop Dispatcher and User Tools provide shortcuts that 
open external programs, BAT files, or DOS operations. These functions are typically 
opened by dragging and dropping a resource onto the shortcut icon. 

DesignPro Tools provides equivalent functionality in the Tools & Utilities tab in the 
Manager. Shortcuts are set up using a wizard. Open the associated utility or application by 
either double-clicking on a tool icon or dragging and dropping a file onto an icon.

Transformer
The Transformer is not completely supported in this release of DesignPro Tools. The 
Elixir Application Suite Desktop Transformer does provide a series of functions that can 
be performed against Elixir forms and images. Full support will be available in a future 
release of DesignPro Tools.

Loader
The Elixir Application Suite Desktop Loader is a simple interface for transferring files to 
and from an IBM host. The Desktop provides the ability to open a DOS version of a third-
party terminal emulation package’s file transfer program, which communicates with the 
IND$FILE host program. 

No equivalent to the Loader is provided in DesignPro Tools. This is due to the many easy-
to-use Windows-based terminal emulation programs available and host support for 
common file transfer protocols like FTP.

Proof Printing
The proof print process no longer requires special PCL fonts in this release of DesignPro 
Tools.
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Conversion from Microsoft Windows and PDF File Formats

Elixir PrintDriver Pro uses the Windows print function to convert Windows-based and 
PDF documents to Elixir or target printer format forms. It also provides several options for 
handling fonts and images. True Type and Adobe fonts can be converted to either AFP 
format fonts; document images can be converted to page segment format. Font and image 
conversions can be performed simultaneously during the form conversion. Files converted 
using Elixir PrintDriver Pro can be edited in the DesignPro Form Editor.

Proofing Variable Data Applications 
Elixir Viewer provided with DesignPro Tools is an improved version of the previous Elixir 
Application Suite Elixir Viewer. Elixir Viewer provides an on-screen viewing and test-
printing of documents and forms to check object and text placement before final printing. 
You can also run data proofing with sample data to preview output from Visual PPFA. 
Data proofing combines Pagedefs, Formdefs, data, and other resources to generate an 
instant preview of the final job, therefore, eliminating the need to run proofing on 
production printers and saving valuable time.

Supported formats:
AFP (MO:DCA) Document (AFP)
AFP Overlay Object (OVE;01)
AFP Overlay Source (OGL)
Elixir DAT files (DAT)
Elixir Document (EDF)
Elixir Form (EFR)
Elixir GDF (GDF), Elixir Legacy Form (ELX)
Elixir PrintDriver Document (EPL)
Elixir PrintDriver Form (EP)
Postscript (PS), Windows EMF (EMF)

Elixir Viewer uses the same configuration and conversion capabilities as Elixir input 
parsers to display pages on-the-fly. Elixir setup files (EPM) configured using the Elixir 
Converters can be opened in Elixir Viewer to set up the properties for input formats. For 
more information on Elixir Viewer, refer to the Elixir Viewer Online Help.
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Automated Processing
DesignPro Tools provides Elixir Scout Manager for automating various processes. Elixir 
Scout is an integrated system service that watches directories for a file or an event. When 
a specified file is present or an event occurs, Scout can perform a user specified action. 
These actions can include launching an executable (EXE or COM), running a batch file 
(BAT or CMD), or selecting a process (DLL).
Elixir Scout Manager runs in the background as a Windows service, providing event-
triggered directory "watch" capabilities. It is used to configure Scout and provide a UI 
window for operations. For more information, refer to the Elixir Scout Manager Online 
Help.
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